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Overview

What is NEO Pro

A new way to think about email

If you’'ve been struggling to organize your email, it's no wonder. As email piles up in
your Inbox you soon become swamped — if you organize by folder you're continually
filing messages, and if you don’t, you can't find messages when you need them.

The problem with email programs is they shoehorn you into an Inbox/folder mentality —
they only show your messages in one way. You can filter them but you can’t easily
view the same messages in different ways.

Think of NEO Pro as an intelligent email sorter. It automatically organizes your email in
all the ways you think about email — by date, by correspondent, by mailing list, by
attachment, and so on.

Finding messages is a breeze

Your messages automatically appear in more than one location at the same time. That
makes finding them much, much easier, and when you do need to search, our search
is lightning fast.

Companion product for Microsoft Outlook

Nelson Email Organizer is a companion product for Microsoft Outlook 97, 98, 2000,
2002(XP), 2003, 2007 and 2010. It works with the Internet mail only, corporate and
workgroup, and Exchange Server platforms.

NEO Tutorials

Getting to know NEO Pro using our online tutorials is time well spent. There are
several bite-sized videos to choose from. We suggest you start with the NEO Primer.

http://www.emailorganizer.com/products/webinars tutorial.php

How NEO Pro Works with Microsoft Outlook

NEO is an add-on product to Microsoft Outlook and works with Outlook 97, 98, 2000,
2002, 2003, 2007, 2010 and Exchange Servers 5.5, 2000, 2003, 2007 and 2010.

Alternative interface for your email

NEO Pro is an alternative interface for the email component of Outlook. NEO Pro is
not intended to replace the other features of Outlook. You can easily switch
between NEO Pro and Outlook, and interact with some components of Outlook.

Although you must have Outlook installed, you don’t have to have Outlook open to use
NEO Pro.
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Using Outlook features from NEO Pro

Wherever practical, NEO Pro was designed to work the same as complementary
features in Outlook. You can compose, reply, reply all, forward, send/receive, mark
read, and so on - the usual message actions — all from within NEO Pro.

Here are Outlook actions you can take from within NEO Pro:

e  Switch quickly to Outlook , or switch to an area in Outlook such as contacts, calendar
(see the Outlook command on the NEO Pro toolbar).

e Open anew item in Outlook such as a new appointment (see the New dropdown on
the NEO Pro toolbar).

e Open the Outlook contact record  for any NEO Pro Correspondent , or create a new
one (right-click any message or name folder).

e Drag and drop messages to non-email Outlook folders such as contacts and journal.

NEO Pro also depends on some settings configured in Outlook.

Same message store

Your email messages are not duplicated in NEO Pro — the messages remain stored in
your Outlook or Exchange Server message stores.

Like Outlook, NEO Pro interfaces with your underlying message stores. When
messages arrive into your message store, NEO Pro is notified. When you send or
delete messages from NEO Pro, your message store is updated in exactly the same
way it is when you send or delete from Outlook.

Indexing and the Catalog

NEO Pro works by creating indexes to your messages and storing the indexes in a
separate NEO Pro catalog. Whenever messages are sent, received or updated in the
message store, NEO Pro automatically updates the indexes in the catalog.

Normally you would include all your message stores in a catalog.

How NEO Pro works with Exchange Server

NEO Pro works with Microsoft Exchange Server mailboxes.

However, NEO Pro is an email organizer. It does not organize other Outlook object
types such as calendar items, journal items, and note items although it does provide
ways to interact with them.

Here are some notes about using NEO Pro with Exchange Server:

NEO Pro is a client-side product

That means NEO Pro installs and operates completely on your computer. There is
nothing about NEO Pro that gets installed on the server or that is related to Exchange
Server. In fact, Exchange Server is completely unaware of NEO Pro.

You can organize your Mailbox and your PSTs

You can include your mailbox and as many PSTs as you like in your catalog. NEO Pro
will give you a seamless view to all your messages. NEO Pro makes it appear as
though it's all in your Mailbox.

Using your offline message store (OST)

When using Offline mode or Cached Exchange Mode it is best to delete messages
from within NEO Pro. If messages are deleted outside of NEO Pro (in Outlook or via
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an Outlook Rule), they may not disappear from NEO Pro until a Full Sync is
performed.

Offline mode using Outlooks prior to Outlook 2003

If you have offline access enabled (you use an offline message store), you should
select all your email folders for OST/Mailbox synchronization. In addition, you should
not set filters for your folders.

You will not lose messages when you do this; however, if you do not include all your
folders NEO Pro may spend quite a bit of time removing and adding messages in the
catalog each time you switch between your OST and your mailbox.

If you have instructed Outlook to automatically Outlook synchronize your Exchange
mailbox with your OST when exiting an online session, you must shut down Outlook
without NEO Pro running for the synchronize to be performed.

Cached Exchange Mode
NEO Pro works normally with Cached Exchange Mode.

Reminder — Synchronize each time you re-connecttot  he LAN

Whenever you re-connect to the LAN, you must synchronize to update NEO Pro with
new messages from your mailbox. Note that you can configure NEO Pro to
automatically Fast Sync on startup, or get general information about syncing.
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Getting Started

What's New in the latest version

For what's new in the latest version of NEO Pro, please see our What's New for full
details.

Ways to start NEO Pro

It's best to start Outlook first and keep it runnin g

NEO will normally perform better if you start Outlook before NEO starts and if you keep
Outlook running while NEO is running. Otherwise, some Outlook features and some
add-ins such as anti-virus tools may not perform properly.

For those not using Outlook actively, this may seem to be a waste of memory.
However, having Outlook running only minimally increases your memory usage over
not having it running because when not running NEO must open and work with a
hidden copy of Outlook anyway. Note that Outlook can be minimized, and that it can
be moved to the tray when minimized (for Outlook versions supporting that feature).

If you know you don't use other Outlook add-ins or anti-virus programs that depend on
Outlook, then feel free to use NEO without starting Outlook first.

Start NEO automatically when you start Outlook

This is the recommended approach. Enable the option to automatically start NEO
when Outlook starts (see the Startup options on General Options), then always start
NEO by starting Outlook (which will then automatically start NEO).

Start NEO manually
After Outlook has started (recommended), you can also start NEO manually as you
would any application:

o Click NEO from Start | Programs.

o Double-click the NEO icon on your desktop

o Two special ways to start NEO:

0 Hold down the Shift key when double-clicking (and holding it down while NEO
starts) will start NEO without opening a catalog.

0 Hold down the Ctrl and Shift keys when double-clicking (and holding it down until
the confirmation appears) clears user interface settings such as Workspace Layout
and Toolbar configurations, but not your Options or any catalog-related information
(e.g., Correspondent names).

Starting NEO with a specific Catalog by using a com mand line option.

You can start NEO with a command line option to open up a specific catalog. For
example, you could then open more than one catalog without having to choose from
the File menu.

The best way to do this is to create a separate desktop shortcut:

1. Using Windows Explorer locate the program file for the NEO version you are running. This
will be in the folder you installed NEO into (probably c:\Program Files\NEO ...) and will be
NeoPro.exe.
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2. Right-click drag the file onto your desktop. When you drop it choose Create Shortcuts
Here.

3. Close Windows Explorer. Right-click the shortcut you just created, and choose Properties
on the shortcut menu.

4. On the Shortcut tab, locate the Target box. It contains the path for the exe file. Put your
cursor at the end of the field.

5. Press the SPACEBAR once to type a space after the path, and then type -o Catalog
Name. Note that you must enter this at the end of the target field. A sample target might
look like this "C:\Program Files\NEO Pro\NeoPro.exe" -0 My Other Catalog. Note that the
guotes are important.

6. Click OK.

Start NEO from Outlook

Click Go to NEO on the Tools menu in Outlook, or click the NEO icon on the Outlook
toolbar.

Start NEO automatically when you start your compute r
Locate your Windows Startup folder and copy the NEO desktop icon to it.

Note: If you want NEO messages to be automatically synchronized with your
Outlook messages, you must always have NEO open when you have
Outlook open.

Get help from within NEO

Help is available from within NEO via:

Tool tips For a short description of toolbar commands and other command
buttons, roll your mouse over the command. A tool tip will appear in
about one second.

Questions Also available on the Help menu, Common Questions are
answered.
Shortcuts Also available on the Help menu, its worth learning Keyboard

Shortcuts for actions your perform often.

Symbols Familiarize yourself with the icons and symbols in the Reference
section at the end of this document.

Help system  Press F1 or watch for "more info" and Help buttons inside NEO.

If you are new to NEO, be sure to see all the items in the Getting Started section. After
you have used NEO for a while, you may want to visit the Productivity Tips section.

Support and Feedback

Click Get Support on the Help menu.

Things to do each day

Outside of your normal sending and receiving messages, here are the things you
should bring into your daily workflow.

1. If you use automatic Bulk Mail assignment ( default is ‘off’ ), clear out your Unsorted
Bulk Mail
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When automatic Bulk Mail assignment is ‘on’, NEO identifies new bulk mail and puts it
here. If you don't use the Correspondent filter to filter out Bulk Malil it will also arrive in your
Inbox and can be managed from there too. However, if you do use the Correspondent
filter, be sure to check this folder daily because the filter will prevent this mail from
appearing in your Inbox.

. Empty your Spam Senders folder
If you block spam senders, you need to go to your Spam Senders folder in Bulk Mail view
to view and empty it from time to time.

. Empty your Deleted Messages folder
When messages are deleted from NEO they go into the Deleted Items folder in Outlook
view.
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Productivity Tips

Being Productive

You'll get the most out of NEO if you rely on its automated features to do most of your
organizing for you. With that base, you can then use other NEO features such as filters
to help you focus on the messages you need to.

NEO Application Notes

To help you implement the most efficient way of working please refer to our Application
Note on implementing time-management compliant workflow principles. You will find
this Application Note here: http://www.emailorganizer.com/kb/T1165.php.

Our Online Email Training

To boost your email efficiency and for a guided step-by-step implementation of the
most efficient way to manage your emails, please subscribe to our Online Email
Training. More information here: http://www.emailorganizer.com/training/training.php. .

An Introduction to NEO Pro

Use NEO Pro to create and send mail just as you would with Outlook. Here are a few
things to help get you on your way with NEO Pro.

@ First, get oriented by clicking each of the Viewtab S

# Hot For your favorites. Make an Outlook or NEO
folder hot. Most popular view.

& Outlook Manage your Outlook folders here just as
you would in Outlook's Folder List.

%, Comespondent All your regular mail is automatically
organized into Correspondent folders for
you.

El Bulk Mail For your e-newsletter type email. New Bulk
Mail goes into the Unsorted Bulk Mail folder.
Create your own Bulk Mail folders from
there. Bulk Mail can also be assigned based
on the subject.

&8 Category Automatically organized by your Outlook
categories. Easy to edit and manage.

& Status A folder containing all messages in each
state: Unread, Flagged, ToDo, Active,
Important, ..

& Date Date folders: Today, Yesterday, This Week,

.. Dec 1999, Jan 2000, .. Feb 2006, Mar
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2006,

Eﬁ; Attachment

All your attachments auto-organized into
folders by attachment type (e.g., DOC, XLS,

PDF, ..).

,}ﬁ Search

Enter your search words and NEO

automatically searches across all your
folders.

& How NEO works

NEO extends Outlook capabilities in many ways, but there's one feature of NEO that's

worth knowing:

Virtual ~ NEO displays the same message in different ways.

folders

£ Andre Agassi

£, Steff Graf

~. /

¥ Flagged —— (& —— G| Tennis

e

[ Inbox

They are displayed in their Outlook folders and in all the
virtual folders that NEO Pro automatically creates for you.

[E This week

‘ P,

5 2005 Sept

One more thing: don't worry about trying to understand all of NEO right away. Over time
you will discover new things you can do.

@ Note you can continue to use Outlook just as before

oy

Diklonk i

-

o Outlook  Chrl+D
5 Inbox Chrl+1
Calendar  Chkrl2
|£.]  Contacks  Chel+3
w1 Tasks Chrl+4
| | Mates Chrl+5
A 2ournal Ckrl4+a

Options

Ways to use NEO

Click the Outlook button on
the View tab to jump to
Outlook.

Or double-click any of the
following in your NEO
Outlook view.

7 Calendar
G‘.’I Contacts
f}ﬁ'l Motes
7 Tasks

To return to NEO, click &
on the Outlook toolbar.

Using email involves managing messages and finding messages.

Here are three ways to manage messages with NEO:

@ Stay on top of your incoming mail
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Like Outlook, all new mail comes into your Inbox. However, with NEO:

e Messages are much easier to find - there's less (no) need to file to specific
folders. Using NEO Pro you can easily use a single large archive folder

e Keep your Inbox small. You can use it for your To Do or you can use NEO’s To
Do folder for your To Do’s - messages you still have to take action on.

Ok, so how do you keep your Inbox small without the hassles of filing?

The key is how you file . In NEO you can quickly move messages out of
your Inbox. You can file to your recently filed-to folders, and you can file to a
single 'quick file' folder that you designate - perfect for messages you don't
want to think about where to file (after all, isn't that where most of the filing
frustration comes from ... deciding where to file a message).

Turn your Inbox into your To Do : file messages you are finished with but
want save, and leave in your Inbox messages still requiring action.

Or, empty your Inbox by using NEO’s To Do  : assign messages still
requiring action NEO’ To Do flag (high, medium or low priority) and move
them also out of your inbox.

Use Quick File to keep your Inbox small

Click Quick File on the toolbar to file to your designated Quick File folder, or
click Quick File Recent on the toolbar to choose from other recently filed-to
folders. Pressing Backspace will also bring up your Quick File Recent menu.

It all comes down to two easy keys - Delete, Backspace:

Not Neaded? Sends to
Delete Deleted Items
Rasd Action Mow? Leave in Inbox
Mesage | = | Ry, Farwart | — | ‘Action later? | Of azzign MED's
ToDo
.
Done? Cuick File Recent -
i muowe out of Inbiox
T to another folder
Remember: Backspace doesn't delete the message! It just helps you file
the message to another Outlook folder, so you can keep your
Inbox small.

In NEO Pro, there are other organizing things you can do with messages
such as Keeping messages and Categorizing messages.

Flexible filing to any folders
As with Outlook, you can also file by dragging to folders, using File to Folder,
or Outlook Rules.
& Focus on your priority mail
Bring forward your Correspondent mail

You can let NEO automatically separate your regular Correspondent mail
from your Bulk Mail (e.g., e-newsletters).

If so you can choose when to just see your Correspondent mail, your Bulk
Mail or both. Most NEO users just want to see Correspondent mail during the
business day, and see their Bulk Mail at specific times such as first thing in
the morning.
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= On the Filter tab, click icons to show just Correspondent or
4 Carrespondent Bulk Mail messages respectively.

£ Bulk Mail
Class
Zero in on folders with Unread messages
You can also filter NEO to just see folders that contain unread messages.
The ‘Folders with Unread messages' filter is especially

(R Falders with Untead — helpful in Correspondent view but applies to Bulk Mai

Eﬂ Folders vith Active and Outlook folders too.

Folder

Notice that when a filter is set the background color changes to let you know
a filter is active (you can change the filter background color). To clear the
filters, unclick them.

@ Things to do each day - or at least often

Outside of your normal sending and receiving messages, here are the things you
should build into your daily workflow.

1. When using automatic Bulk Mail assignment (  default is ‘off’ ), check
your Unsorted Bulk Mail folder

You can let NEO identify new bulk mail automatically which puts it in the
Unsorted Bulk Mail folder. If you don't use the Correspondent filter to filter out
Bulk Mail you'll set it in your Inbox and can be managed from there too.
However, if you do use the Correspondent filter, be sure to check this

folder daily because the filter prevents this mail from appearing in your
Inbox.

By default NEO will place all new Bulk Mail under Correspondent folders so
you can do the Bulk Mail assignment manually yourself.

2. Empty your Spam Senders folder

If you block spam senders, you need to go to your Spam Senders folder in
Bulk Mail view to view and empty it from time to time.

3. Empty your Deleted Items folder

When messages are deleted from NEO they go into the Deleted Items folder
in Outlook view.

Finding Messages Quickly

Conversation View

To enable click the Conversation View button on the
e Quick Access Toolbar or on the View Tab.

% All messages can be viewed within their e-mail thread.
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Search for a message using the Search entry box

Inbox
YA Y E T A {4 Name

DEQ &

Subjeck

Date/Time ©

Enter a search word into the Search entry box which is available in all views
above the message listing. Press Enter (or click the left icon) to search through all
message stores or press Shift+Enter (or click the right icon) to search only in the

current folder.

Search for a message using the Search tab

or click Go.

Search

Eraining
o7

Folder:

Im: [v]Subject [+]Body
Mames/addresses
Attachment narme

Date: (34l ) Recent
Match: [ Similar waords

All Folders

@

Click the New Search button on the ribbon
(Shift+Ctrl+F). Enter the search term and press Enter

You can use
logical operators
like and, or and
near.

Or change options
or parameters to
limit your search
such as searching
within a folder.

Search on Conversation ( alternative for Conversation View )

:}3

To find the conversation for a single message, highlight the
message (e.g., with subject ‘Marketing Plan’) then click the

Search on Conversation button on the ribbon (Ctrl+Alt+F) to
find all messages in the same conversation. Alternatively the
Conversation View can be switched on.
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Current Search Results

EB G &

DatefTime ©

87 E Y Q4 Name
[

19-Jul-10 10:27

a 4+ Paul Laan

RE: Marketing plan
8wy Paul Laan

RE: Marketing plan
a2 4 Paul Laan

Marketing plan

Find a Correspondent quickly

18-Jul-10 14:37

18-Jul-10 14:34

Click the Find Correspondent button on the ribbon
(CtrlI+F3). If looking for Fiona Mackay, enter mac in
the Folder List filter to short-list your Correspondents

for easy selection.

- The changed
G Clear Ts @ background color
| Hare | tells you that you
£, Macleod, Della have a Folder List
£, MacDonald, Karen filter active.
B Macdonald, Noel _
§ Macintosh, an T(_) clear the filter,
§ Mackay, Fiona click Clear or press
£ Machintch, Robie the Esc key.
£, MacPherson, Janice

Jump to all messages for a Correspondent (or Bulk M

(g8 Jump to Folder. ..

Click the Jump to Folder (Ctrl+J) button on the
ribbon to display all messages for the person from

the currently selected email.

Learn keyboard actions

ail folder)

Using the mouse is generally great but it can be slower for actions you do over and

over again. Using the mouse along with keyboard shortcuts provides the best

performance.

Consider all the time you spend moving your hand off the keyboard and onto to the
mouse, then back again. Not everyone is a keyboard enthusiast, but even if you learn

a few (or a few more) you'll save time.
Here's a technique for learning more:

1. Print the Keyboard Shortcuts on the Help menu.

2. Don't use your mouse for a few hours and instead use the keyboard shortcuts from the list.

3. Learning them all is too much - focus on the operations you perform over and over.

E.g. Press F8 to jump to the Inbox from anywhere in NEO.
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Some basic tips

Here are some basic tips for making NEO more productive for you.

» Work from Hot view and make folders hot

Spend most of your time in Hot view and go to the other views when you need to. Make
folders from other views hot so you can see them quickly. Some hot folder suggestions:
o Correspondents you are currently working with
o Date folders - This Week, Last Week, etc.
o frequently-used Categories
o frequently-used folders from your Outlook view Folder List

» Keep your Inbox or Active Mail small

Whether you choose to work out of your Inbox or out of Active Mall, it really helps if you
actively use the Quick File features or make messages Inactive to help reduce email clutter.
Set your Backspace key appropriately. You can set the Backspace key from Tools | Options |
Workflow tab.

» If you file to folders frequently, take advantage o f Quick File Recent's accelerator
keys

First of all, set your backspace key to display the Quick File Recent menu (Tools | Options |
Workflow tab). Notice that the first letter of each of your recently file-to folders is the
accelerator key. When used in conjunction with Backspace, you can file without using a
mouse. Here's what you type for these sample folders on your Quick File Recent menu:

Reviews  Press Backspace then R to

RS immediately file it.

Eniryenee Meetings Press Backspace then M to
KAST immediately file it.

Meetings Budget Press Backspace then B to
Gold CoM immediately file it.

Budget

DuickFiled

File to Any Folder... Shift+Cirl+y

[ SetQuick File Folder. ..
Clear List

Disable List Updates

» Use Active Mail actively and reset it often

The Active Mail folder shows new mail (when defined under Tools | Options | Workflow tab)
that you have received since the last time you reset it. If you reset it whenever you look at a
message, you'll be able to quickly see when new mail has arrived.

Press F11 to go to Active Mail from anywhere in NEO
Press F12 Make the current message inactive (reset Active Mail flag for
this message)

To reset Active Malil flag for groups of messages, use the following:

Press Shift+F11 to reset All Active Mail messages
Press Ctrl+Shift+F11 to reset Correspondent Active Mail messages
Press Ctrl+F11 to reset Bulk Active Mail messages only

» Develop your own email workflow methods

There's plenty of flexibility in NEO to work with. Think about how you like to process mail and
then put NEO's features to work for you. Review NEQO's options and ensure they match the

way you want to manage your email. Everyone will want to do it a little differently. Connect to
our online Application Notes for workflow ideas — you will find them on our Knowledge Base.
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» Use To Do

By diverting messages to To Do that you have to take action on, you won't have to keep
seeing them as new messages arrive in the Inbox or Active Mail.

Press Alt+1,2or 3 to assign a To Do to your message (high, medium or low
priority); you can now file the message as it will stay in your To Do folder.

Press Alt+0 to clear the To Do status (it remains in the filed location!)
Press F10 to go to To Do from anywhere in NEO

» Don't get distracted by unimportant mail

Reorganize less relevant email to Bulk Mail and use filters to filter them out until you want to
read it. Edit the New Mail options so you are less distracted by unimportant new mail
notifications.

» Don't forget daily housekeeping tasks
See Things to Do Each Day.

» Learn keyboard commands for actions you perform oft en

There’s a keyboard command (e.g. F8 to jump to the Inbox) for just about any action you
take. You'll save time if you learn even a few.

» Use Conversation View and Search to find messages

Switch on Conversation View to find related messages instantly. Search is very fast in NEO.
Consider using it to quickly find messages. Use the search entry box available in all views to
quickly get to your messages. Or press Ctrl+Shift+F to start a new search from the Search
tab.

» Use the Folder List filter to find folders quickly

At the top of each Folder List you can enter characters to narrow down the list of folders.
Using this, especially in Correspondent and Category views, can be a huge time-saver.

Press Ctrl+F3 to quickly find a correspondent in Correspondent view.
Press Shift+Ctrl+F3 to quickly find a category in Category view.
Press F3 to go to the Folder List filter of the current view.

p» Create Bulk Mail folders

Bulk mail consists of your mailing list messages and other less relevant messages.
Reorganize these messages into Bulk Mail folders so your less relevant mail will be
organized separately. Using Active Mail as an alternative for the Inbox, you can configure to
only show (relevant) Correspondent Mail in your Active Mail folder (from Tools | Options |
Workflow tab).
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Options & Customizing

Your Addresses

About Your Addresses

NEO needs to know which addresses are yours in order to automatically organize your
messages. If all your addresses are not entered, your messages will not appear
correctly.

Note that NEO must know all your addresses - not just your currently used ones. Be
sure to include your old addresses if you have messages that used them.

Auto-detecting your addresses on catalog creation
NEO automatically detects your addresses when you create a catalog, and you can
add to the list NEO auto-detects. Addresses you enter are displayed in bold.

Important Note: NEO does not auto-detect addresses you use after creating the catalog.
You have to enter these manually.

Adding and removing addresses

You can add addresses and you can remove addresses you add. Addresses NEO
auto-detects cannot be removed - however, you can choose not to include them by
unchecking them).

Click the Application Button menu | Your Addresses to keep your addresses up to
date.

Your Addresses

MEQ Pro needs to know which addresses are yours in order to
automatically organize your messages.

Bold addresses are ones that you have entered. Unbolded addresses
are automatically determined (vou can't remove these but you can
uncheck them},

: Elarney'-(:nnpersmith
booopersmith@my_kiue_heaven.com
hcoopersmith@fbi_MY.com

(=] (o=
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To add an address, click the Add command. POP3 email addresses are entered in the
usual way (e.g., bcoopersmith@fbi_NY.com). Exchange Server addresses are enter in
X.500 format.

Options

General Options
These options control NEO startup and other general settings.

Fast Sync on startup
When NED starts, it "fast” synchronizes your messages.
5 Mow yvou are sure all your messages showin NED.

Options Ed
Start NEO Pro when Outlook starts

Prevents NEQ from getting out of syncwith Outlook - this
is the recommended setting.

General | workflow | Reading Pane

Startup f f [
; . Check for updates
7| Fast H kark Mote info : 2
Rt L RNl L St Keep vour NEOQ current by keeping this
Start MEQ Pro when Qutlook skarts option selected. altematively, vou can click

Check for Updates on the Help menu.
Cpen most recently used catalog on startup P : P

Check For NEQ updates on starkup
Close NED when Outloak closes

Your email addresses
Be sure to add new email
addresses when you get them.

Your Addresses. .. Ensure MED Pro knows all wour addresses

Confirmation
Check to be warned before
combining Correspondents.

Your Addresses

Confirmation

Warn before permanently deleting messages

Warn before combining names or categories |
Update Word Index

Search update MEQ indexes all wards in your messages to quickly find
e them._ This setting spedfies how oftento update the
Aukomatically update word indes every |60 rinLkes word index. You can always perform a manual update

of the word index from the Tools menu.
Enter 0 to disable automatic ward indexing.
Toolbar Layout |

|Jse Ribbon (%) Blue ) Black ) Silver

Ribbon or Toolbars
To use tradibional toolbars deselect 'Use Ribbon’,

Also you can choose the Ribbon main color.
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Workflow Options

These options help you configure what happens when you take action on messages,
whether Active Mail operates, and how you want Backspace to work.

Save steps

When yvou take an action, voucan have NEC Pro
- automatically perform other actions for you.

0 ptions

W

Generall: WorkFlow EReading Pane | Format | Mews Mail Alerts | Miscellaneous

Automatic Actions
Mark Read  Make Inactive

When I make a message Inactive

When I set To Do for a message |
When I move a message ko an Outlook Folder
Wwhen I Categorize a message |:| |:|
When I Flag a message | E
When I Keep a message |:| |:|

Active Mail
[CPuk miew Correspondent mail in the Ackive Mail Folder Mare info

[CIPut neve Bulk mail in the Active Mail Falder

Backspace
|Jse the Backspace kev as an alternate key For;

{2 File to the Quick Fils folder (permanent key is Chrl+T)
(%) Display the Guick File Recent menu (permanent key is Chri+-al-+v)
{7 Make Inactive {permanent key is F12)

Unread Mail

[#]Mark read after viewing |5 ::: seconds in the Reading Pane

Mark Unread mail "Read’

Active Mail
Choose which mail classes go into Active Mail.

You can optto either use the Inbox or Active Mail for
your new mail.

Select both options to have Adive Mail show same
content as your Inbox. Or choose to leave Bulk Mail out
of your direct viewto reduce number of messages in
Active Mail.

These options take place from the moment yvou set them
(they don't operate on existing messages).

Backspace key
Make filing very easy by defining vour Backspace key.

If you mostly file to a single folder choose File to Quick
File folder.

Try them out and see what works best.

Define after how many seconds viewing in the Reading
Pane the message will change to *Read’.

Disabled in 'Unread’ folder or with "Unread’ filter active.
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Reading Pane Options
These options relate to the Reading Pane.

Get HTML images online

Check here to automatically get HTML images from
the web for the Reading Pane.

When unchecked, you can always see the images
when you open the message. '

—

ﬁp'i'iu ns

-HTML
Get images from the web when displaying HTML messages Use simpler Tntemnal HTML
[Juse internal HTML viewer More info L Lo
Check this box to use NEDQ's
S8 arver ko access the web internal HTML viewer. Click

"Maore info” for details.

Fork:

Relative bext size For HTML kexk: iMedium E

Plain Text

Set Font characteristics For displaving Plain Text

. How plain text is viewed in the Reading Pane
Item preview

[ ]Enable exchuded Falder items preview (not recammendead)

Whether Spam and other excluded items are previewed
Compact layout

(&) automatic () Always (multi line) ) Mever (single line)

Compact Layout
Default Note Text = Reducing size of Message Listing will switch to double

line below a certain size. This can be controlled here.
Set default Font characteristics For notes

Mote Text formatting
Define default Font format for message Motes.

oK J [ Cancel
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Formatting Options

Mames in Correspondent View

These options set how items are formatted.

Warious arrangements of Last, First and Company

-~

‘Options

values for these folders.

—

X

i-Genere_ll | Warkflow | Reading Pane | Farmat | Mew Mail Alerts | Miscellaneous |

Manie Format

Folder lisk: |Lasl:J Firsk - Compans

Ttemlist: |First Last

Date Format in Lists

) Relative dates (e.g., Today 14:43)

(%) absolute dates fe.q., 04-Mov-10 14:43)

YWeek begins on: |rl"-'1|:|n|:|a~;.-' !vl

Colors

Date/Time columnin list pane

Relative dates apply for most recent two weeks,
then absolute dates are used.

Sent messages:

| B window Tewxt

[ Apply J

| W Bl

Received messages:

Filter background: ||:| Cuskarm, ..

Conversation Parent: ||:| Custon, ..

Conversation Child: ||:| Cuskom..,

Hot ¥iew folders

Add store name ko Qutlook folders {restart needed)

Hot View folders
When selected, Outlook folders in Hot wiew coming from

non-default message stores will show with store name
(e.g. Deleted Items in PST2009].

Color Settings

¥ou can choose standard colors or define
your own color by selecting Custam.
Click Apply to see howthe changes look.

After changing this option, NEQ Proneeds to be
restarted to update Hot view folder format.
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New Mail Alert Options

These options set automatic notifications that take place when new mail arrives (you
can also learn how to change Outlook’'s new mail settings).

What happens when new mail arrives
For each type of message, indicate whetheryvou
want to show an icon in the system tray (with or

r— without popup], and/for play a sound. —
Options -
General | Workflow | Reading Pane | Format | New Mai dlerts | piscellaneous |
When new mail arrives
Show Icon Show Popup Play Sound
Hot messages E b
Correspondence Y 4
) Click here to test
Bulk. rnail % » your selected sound
Outlook new mail Quick overrides
) Popup
How to disable Outlook's [ ] Disable sounds :
new mail sound and bray icon Sapm window e
[ ] pisable popup window showing newly arrived mail.
MED sound scheme
T T - Disable Dutlook’s notification?
|Bels -q a3 Click here for information how ta disable

Cutlook’s mail notifications.

Choose a sound scheme
Pick fram the list to choose wour sound scheme.

Click Set Custom Sounds to set yvour own sounds. Opens the Windows
Sounds Properties dialog. Sound scheme must be "Custom’.

(o] 4 ] [ Zancel
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Miscellaneous options
In this tab several additional options can be set as described below.

Keep focus on messages
When browsing through different folders focus will
f - always remain onthe message listwhenseleding
Options this option. @

| General | Workflow || Reading Pane | Format | New Mail Alerts | Miscallansous |

Keep older messages out of NEQ's catalog
Browsing Messages older thanthe selected date will be excluded from NEO's catalog.
Afull sync and update ofthe word index will follow changing this seledtion.

Synchronize options Keep the Word Index up to date

[[Juse time limit For old messages When selectedwill force an up date ofthe word
I o index after performing a full synchronization,

T s e i |

Define options for minimizing NEQ

- Hidewhen minimized: MEC hidesinsystem tray
; o - Minimize on startup: NEQ will minimize upon starting
H'de NEO Pro when minirized Selecting both options causes NEQ to hide immediatelyin the

|:| Minimize MEC Pro on skartup system tray upon starting.
|

[[Jkeep Focus on message list when changing Folder

Do nat svnchranize messages older then

[Tupdate word index after Full sync

Minimize options

Inbox options
This defines whether to show the ‘Filed' iconfor messages in
Show Filed' status For messages in subfolders of Inbox subfolders ofthe Inbox.
I
Unread Folder options

i ; When seleded, unread messages showinginthe
Delayed cleanup of Read’ messages Unread folder {on 2tatus tab) will remainvisiblein
this folderfor ~1-2 hours after becoming ‘Read’,

Inbox options

Unread Folder options

Conversation view
Use all Folders except Excluded and Deleted Items

Conversation Integrity Conversation view settings
Conversation Integrity will propagate actions onthe

‘parent also to underying ‘chilcs’, e.g. Status

Exernal devices A I
changes, Category actions, Filing and Delete.

Avaid conflicks with external devices (restart needed)

External devices

UsingNEQ Pro together with another external device like smart-
phone can generate conflids when using an Exchange Serverin
Cached Exchange mode, Selecting this optionwill prevent this
from happening. After changing MEQ: needsto be restarted.

Other Ways to Customize

Resizing the Reading Pane

The Reading Pane can be positioned either at the bottom or to the right of the screen.
This can be defined on View menu. Size of the Reading Pane can be changed to any
desired size by dragging the pane separator to a hew location. Switching off the
Reading Pane is done on the View tab.

Note that you don't have to see the Message List pane in order to read them in the
Reading Pane. You can use the following shortcut keys to move from message to

message:

Ctrl + Up Move to previous message
Ctrl + Dn Move to next message
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Resizing panes

The panes in NEO can be resized. Place your cursor on the divider between the panes
you want to resize and drag in desired direction.

-

I*
.

Changing Folder List sort order

Each view can have its own sort order. Change the sort order by clicking one of the
three buttons at the top right.

Alphabetical Order

Strictty alphabetical. Location shows which
top-level or mezzage ztore the folder

Tree Order

Shows top-level folders, group
folders and folders in a

hierarchy. belongs fo.
1 Correspondent ®] ¥ Correspondent B v Correspondent
& |B= R [ # TalRdifg &£ TR

= Hew A MName Location T Lecation
4 Crockett, Morton (1) 6 (Entex), KarinMeier  Dormant A % Lane, Bennett (1) New
4 Delarosa, Buford (1] § 25035283838ms... Dormant § Furrow, Linda (1) Current
& Dillard, Reland (1) § 2503528383@tex.,. Dormant §, Valenti, Billie (1) New
& Jennings, Mary § 754533Egensyre... Dormant § sophia@mindnet New
4 sophia@mindnet (1) R sbanfisids Darmant & Taves, RuthAnne  Current
& swan, Barry (1 & abc@casio.com Dormant @ Chichmanian, Vi... Current
& valenti, Billie (1) § about.comCompu... Dormant 5 Cark David (1)  Curent
5 White, Taylor {1} 3 pocounts@perther,..  Current ﬁ, Diflard, Roland {1} New

(= Current § ACD Systems Dormant & Swan, Barry (1) Hew
& sccounts@perthweh.co... & Administrator, Sys... Curent § Delarosa, Buford | MNew
& Administrator, System & sfflsite@cacio.con  Dormant L Johnston, Terry (! Currsnt
8 Amaral, Bob § afflate@Ecasio.com  Dormant § Crockett, Morton New
B Amazon.com & Amaral, Bob Current 8 White, Taylor (1) New
g i, & 8 Amazon.com Current & Jernings, Mary New
8 Amne, shirley §, Andsrsom, Christy  Darmant & Brocewell, David Current

Recently used order
Folders that have had the most
recent activity display first.

Changing Reading Pane fonts

There are three message formats for the Reading Pane: HTML, Microsoft Outlook
Rich Text, and Plain Text. Here's how the change the text characteristics.

HTML messages
Change the relative size of HTML text in two ways:

e Click View menu | HTML Text Size.

e Set on via Reading Pane options (Tools menu | Options | Reading Pane tab)
Plain text messages
Change the characteristics of Plain Text messages:

e Set on via Reading Pane options (Tools menu | Options | Reading Pane tab)
Microsoft Outlook Rich Text
This message format cannot be modified in the Reading Pane.

=

(i}
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Moving the View tabs

The NEO View tabs are positioned by default at the top of NEO because the tabs are
easier to access there. You can position them at the top or the bottom of NEO.

Right-click on any part of the View tab and make your selection:
. unu:iu:ud-c .
Top
v Bottom

Undocking and docking views

When you start NEO for the first time you will see the default NEO workspace. In it,
Hot view is in the top left panel, Outlook and Correspondent views are below it, the List
Pane is in the middle and the Reading Pane is to the right of it.

The top left view is the home view position . When you click a view on the Viewtab, it
replaces its contents. The home view position, the List Pane and Reading Pane cannot
be moved but they can be resized.

Optimize view positions to suit your workflow

All view positions are configurable in NEO. You can undock any view and have it float
above your workspace, you can dock the views onto the workspace surface in any
position, you can change the order of the views on the View tab, and you can even
hide a view.

From the View | Layout tab, you can load a predefined view with NEO views left and
right of the Message Listing / Reading Pane. To illustrate, here's an example layout
with views left and right.

Hot List Fane Category
Wiew Wiew
depends
on
ourment

WY

Reading Pane

Cutlook Search
Wiew View

Save your Layout settings by exporting them

When you have finalized setting your layout, it is best to save your layout settings by
exporting them: View | Layout | Export Layout.... When it is necessary to reset your
User Interface it is easy to restore your layout by importing the saved settings.

How to reset the User Interface

When you like to restart with the original layout, or when the User Interface needs to
be reset:

Reset your layout On the View menu, click Layout | Reset Layout. This will restore
your layout to the default layout.
Reset User Interface Close NEO, click Ctr+Shift while double-clicking NEO icon to start

the program. Confirm dialog to reset the User interface settings.
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Configuring your views

The key point to remember when moving views is that a view can only be moved to a
new location when it is undocked (floating).

Undock a view that is currently docked on the Viewtab
Double-click the view on the Viewtab.

Undock a view that is currently docked on the workspace surface
Double-click the titlebar of the view panel.

Dock an undocked view back onto the Viewtab

Drag the floating toolbar's titlebar on top of the Viewtab. As you move it over the
tabs, drop it when the insert indicator appeatrs.

Dock a view onto the workspace surface

If it is not already undocked, double-click the tab (if on the Viewtab) or double-click
the titlebar (if already docked on the workspace surface).

Now that it is undocked, drag it by the titlebar to a dockable location. As you get
close to a location it will snap into place with a line marker indicating its location.
Drop it where you like.

To move it so that it appears as a vertical column, place your cursor exactly on the
juncture between two stacked panes (for example, the dividing line between the
List Pane and the Reading Pane).

Hide and restore a view
To hide a view, press Alt+F4 when the view has the focus and is undocked.

To restore a hidden view, go to View menu | click Views then click the view you
want to make visible again.

Adding and changing columns

Column sort order

Sort your messages by changing the column sort order.

¢|E|ﬁ||‘§‘||ﬂ|TD|Name |Su|:|ject |Date,l'Time o

The indicator on the Date/Time column signifies the current sort column. Click it again
the change the sort direction, or click another column to change the sort column.

Each folder can have a different sort order.

Changing column width

Place your cursor at the start of a column until the resize icon appears (see below),
then drag it right or left.

| Ta | Marne éiul:uject

When you change the column width for a view, it changes for all views except
Attachment view which can be set independently.

Changing column order

Left-click drag the header of a column and drag it to the new location.
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Selecting which columns to display

Right-click on any column. This list of available columns will appear for you to check or

uncheck.

